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Please Note
COSA PRIMELink only works with Internet Explorer 7, 8 and 9
Compatibility settings must be change for it to work with IE 10 and IE 11

See page 20



Logqging into PRIMELink

PRIMELink is a web-based application and runs from any computer with Internet
Explorer 6 SP2, 7, 8 or 9.

If yvou are using IE 10 or 11, please see page 20 of this User Guide.

To login into PRIMELInK, go to https://primavera-unifier.oracleindustry.com/bluedoor

You will enter your username, password,

and if it prompts you, select “City of San Antonio” for company,
NOTE: Your username and password is provided by the PRIMELink Team.

FYI: If your PRIMELIink session is inactive for more than 1 hour, you will be automatically logged out from
the system. The system will remain open on your screen, but you will be prompted to login again.

Any unsaved information will be lost.



Change Password

Oracle or the PRIMELink Helpdesk will send you an e-mail that contains your
username and password.

It is advised you change your password as soon as you login into PRIMELink for
the first time.

Log on to PRIMELink
1. Click on the Preferences link on the top right corner of the page.
2. Select the Security Tab

e Enter your new password

e Confirm your new password
NOTE: Your new password will take into effect next time you login into PRIMELink.

3. Password Recovery Secret Questions
e Please select 2 or 3 Question & provide Answers

When the User Preferences window opens, click on the Security tab.

To change your password
Click the Security tab \l:l

Click to view password policy.

Please
// update at
least 2 of
these

guestions!!




Change Attachment Preferences

To be able to attach documents to PRIMELink please do the following:

Go to Preferences, click on Options, and make sure the “File Transfer Option”:
has either “Basic” or “Intermediate” —
Check “Always Use Unifier”, make sure it has - dwg:dgn

Do not change the checkmarks!!!

= User Preferences - Microsoft Internet Explorer provided by City of San Ant... |Z||:E|
£ | https skire.com ﬂ

" General [  Security options | [N

Time Zone: | GMT -06:00, Central Standard Time (Chicaga) v|

Date Format | MM/DDYYYY HH:MM AW v/

Default Viewer: | Mative v|

Viewer Exceptions:
Uise semi-colons to separate extensions.

Always Use MNative: | |

Always Use Unifier: |dwg:dgn |

File Transfer Option:
Default Login View:

Email Subscription;

termediate

[lUse Custom Dashboard as default login view

[Isend notifications in single daily digest

Workflow Business Processes
[¥] Personal tasks

[l Decline tasks

[#] Overdue personal tasks
Messages

Discussion group comments
Record workflow complete
Recard Madification

Non Workflow Business Processes
[IRecord Creation
] Record Modification

Document Manager - Project/Shell
[ Decument upload
[ITransfer ownership

[IMove

Apply ‘ QK ‘ Cancel

Done

@ Internet

.
v;‘l o7

& 100%

-




Navigation Tabs

PRIMELInk uses a tab layout for navigation. The main three main tabs are:

Home is the default landing page.
Contains overall information

Company Workspace contains the
User Access Request Form

CoSA contains all current
On-Call Contracts and Projects

If you do not see the CoSA tab and you
have a contract or project in PRIMELInk,
call the PRIMELink Helpdesk

at 210-207-2019

Home Tab

From the Home tab, you can do the following:
e Review all of your project’s Tasks, Messages, Drafts and uMails
e View system-wide announcements

Tab Navigation

System-wide
/ Announcements

Your ltems

Task / uMail Log




When you click on Tasks you will see something like the below:

New Task

e Tasks displays all tasks that you have received. Tasks include items that require
review, approval, comment, etc.
0 A new task appears in BOLD
0 A late task appears in RED
0 A previously viewed task but not completed appears in normal font
e Messages displays copies of items which you have been cc'd
e Drafts displays saved drafts of items you have created but not sent
e uMails displays internal e-mail messages sent within the system

View Pending Tasks
All Tasks:
Click on the Home Tab
Select Task

Project Specific:
Go to your project or from Home tab click on project
Select Task from the Dashboard

View Draft Records

When you start a new item in PRIMELink and you have to get out, sometimes the
system will store it has a Draft Record. Please keep an eye on this item. You do not
want to have a lot of Draft Records. To clear them do the following:

. Click on Draft Records in the upper right corner

Highlight one line (you can only do it one at a time)

. Click on Delete on the bar above

. Continue until all the Drafts have been deleted.



CoSA Tab

The CoSA tab contains all the current On-Call Contracts and Projects. You need to go
to the far right side of the screen and select either: On-Call Contracts or Project.

To enlarge this item
Click on the small screen

Select either
On-Call Contracts
Or Project

Modify CoSA Tab

1. To put Contract or Project Names in order
Click on the column header

2. To see more items per page
Click on the Display

3. To open your Contract or Project
Click on the name




Letters before Project Names and Names stand for the following:

B — Building and Equipment Services

E — Environmental On-Call Contracts

F — Traffic Management/Operations Projects and On-Call Contracts
H — CIMS and Public Works Horizontal Projects and On-Call Contracts
J — JOC On-Call Contracts

K — Parks Department Projects

P — Public Works On-Call Contracts and Projects

R — Real Estate On-Call Contracts

T — Technical Services On-Call Contracts

V — CIMS Vertical Projects and On-Call Contracts

VS — Convention Center Expansion Projects and On-Call Contracts

Bookmarks

You can create Bookmarks to frequently accessed Projects or On-Call Contracts.

1. Navigate to the desired Project or On-Call Contract
2. Click the Bookmarks link on the upper right section of the window

3. Click Add to create the bookmark
Bookmarks
/ link
Click “Add” to create /

Bookmark

If you want PRIMELIink to open at your project, click on Organize then put a Checkmark
in the Default Logon block.



PRIMELIink Forms

You will be completing forms by entering information into form fields or selecting options
through pickers, drop-down lists, and check boxes.

PRIMELIink forms consist of one or more sections: Upper Form, Action Details, and
Lower Form.

Upper Form

Action Details

Lower Form



Upper Form

The upper form contains basic information. Fields in all forms will vary: editable,
required, and read-only fields.

Editable fields are shown by a white background text box

Required fields are shown by a red * after the field

Read-only fields are show by a blue-gray text box

Pickers allow selecting from a list of options. Once selected, a dialog box will
appear allowing to select from a list.

/= Contract Change Request - AM-09 Traffic Control Exhibits-ATT ROW staking-Add - Prc iplo... |Z||: :

If you received a Task

£ | https skire,com You must either click on
File Edit View Acions Help Accent Task or Decline Task
Accept Task 2 Decline TCIose Window
+# Contract Change Requ... Contract Change Request =
General H
Project Number:[40-00047 | Project Name:|H - Broadway Corridor - Phase I A |
Record Number{CCR-0000004 | Status:[Commitment_Pending |
Title:[A-08 Traffic Control Exhibits-ATT RO Contract#: 4600008650 |
Creator: CLAUDIA VALLES-TOVAR Creation Date:|12,l1 9/2012 02:23 PM Local (GMT-6) |
: Tune Cnntrart [Faciccaca - Vendnr Mame [Frrear & ke an oomae 1 E
% Task Details o

If Workflow Actions is shown
an input is required to send ‘

your item to the next step

{= Create New Contract Change Request vided by City of 5an Aniznio |:||: E'
& | https skire.com
File Edit View Actions Help Workflow Actions |—Se|e|:1— v|
(=1 Send Save % Spelling.. Add Attachment = Close Window .
L @ Contract Change R " Click here to expand
«Z Contract Change Requ... ontract Lhange heques upper form \E
/l Read-only field | -
— General
Project Number: |TEIE—04 | Project Name: |WaIkThr0ugh Project | .
. . Picker
Record Number. | | Required field | | |
Title: | | * Contract #: | select” | *
Creator: Fernando Hernandez Creation Date: | |
Type Contract: | | Wendor Name: | |
Agency: | Select- v Change Category: | gelect- v *
Change to Contract Cost: | g_gg| Change to Calendar Days: | | *
— Description Of Change L |
Description of Editable fields *
Change: /
Justification for
FProposed Change:
—




Action Details

An action detail shows that the task will be assigned to in the next workflow step,
who it will be emailed to and workflow status.

Depending on the
setup, the To and
Cc boxes will
auto-populate

Task Status: Click on
View Only to see where
the item is in the workflow

Task Notes apply only
to the next step and
are not stored with
the permanent record

10




Lower Form

The lower form contains fiscal information and has the main content of the record, such
as line items for a payment request, attachments, comments or directions. The following

is an example of a List Items list.

27 Action Details N E|_
({Click here to view latest content)
“~Task Notes:
Send For:
(= standard
m|
Current View: All Show Currency in: | Transaction Currency w
Double click to view/edit
1 Item(s) this line of information Page [1 of 4 Display | 100 (8] fems per page
Mo, = ltem Mo. Spec Mo. ltern Description UM Unit Price Cluantity Amount PO
001 5 Additional Senices LS 50,000.00 1 50,000.00 |:|
Click to add other
o lines of information ED
/ = = )
=F Adda | Copy « | [# Import M Remove | [ Grid | @, Find | Total Amount: $ 50,000.00
Attachments :0}\ Linked Records (0) General Commems\ Linked Mail (0)
Click to view Click to add/view
Attachments General Comments

Help Files in PRIMELink

On some items there Help Files at the top, to see if there are help files on an item,
do the following: (You must be on your project and on the item you want help with)
(The User, Admin and Reference Guides are from Oracle and not the PRIMELink

Helpdesk these will not help you with your problems)

Field Work Directive Help, PRN Help, RFIs Help
Are just some of the help files that have a PDF help file.

Most do not have a help file yet.

11




Workflows

Most business processes in PRIMELInk have an associated workflow. When you take
and action on a form, you are completing a step on the workflow.

Below is a Request for Information (RFI)

Workflow:
Assign Task in Workflow

You can assign a task to someone else assuming it is allowed.

Open and Prior to accepting a task
Select Edit

Select Add Assignee to Current Step
Select the person

Click on Add

Click Ok

oahrwNE

You will receive a message — “New assignees have been added to ...."

12



Add a Proxy

Proxy will be utilized when you would like to permit someone else to process items in
your absence.

oo N

wN e

whN e

Click on the Preferences link on the top right corner of the page
Click on Proxy tab

Click on Add

Click on Select

e Select the name

e Click on Add

e Click Ok

Enter Start & End Dates (optional)

Click Ok

Remove Proxy
Highlight the name
Click Remove
Click Ok

Login as a Proxy

Highlight the name under — Users | can act as their proxy
Click Proxy Logon
You will logon on their behalf

13



User Access Request Form

This form will be used by the PRIMELink Helpdesk to grant and remove access within the system and track who
requested/authorized the user’s access.

e Form must be completed by the requestor/authorizer within PRIMELink in order to request, remove or
modify a user’s access to the system.

e  Only personnel who already have PRIMELink access will be able to request/authorize access.

e  User Access form functions as other PRIMELink forms, i.e. form is completed, a Workflow Action is
selected and to initiate workflow action the user is required to click on Send action button. Note: Users
are able to copy from previous requests or individual line items within the form tabs.

e Asingle request can be used to request accounts for more than one person, assign a person to more than
one project, assign multiple people to multiple projects or assign people to both Projects and On-Call
Contracts.

1. Logon to PRIMELink
2. Click on Company Workspace Tab, click and expand Company Logs line and double-click on the User
Access — Company business process.

3. Click New icon on action bar in active window to create a new request

14



4. On the Header part of the User Access form, denote in the Remarks text field, a brief description of what
the access request will entail and/or any other information that will be helpful in understanding the
request(s). This information is used by the Helpdesk personnel to determine what needs to be done.
Notes:
e The Header identifies who is requesting/authorizing the user access.
e The fields (i.e. record number, status, and creation date) in the Header part of User Access form are
auto-populated once the request is submitted.

5. Click on the appropriate Action Details Tab(s) to open up the detail portion of form for completion, see
Steps 5a — 5d.
Notes:
e There are four Detail Forms with tabs entitled
Accounts, Projects, OnCall Contracts and Templates.
User can use more than one tab on a single request.
e The type of access request determines which tab(s) will need to be completed.

15



5a. Click on Accounts Tab, to add, delete or modify a user’s PRIMELink account.

Use the scroll bar on right side of window to view and complete all of requested information.
Click on Add function button on the bottom of the Account Tab detail section.

To Add User Account
1. Select Add from Action drop-down list.

IF THE PERSON ALREADY HAS ACCESS TO PRIMELink, DO NOT USE THIS!
GO TO ONE OF THE OTHER TABS

2. User Access Account window will appear. Must complete all of required fields (marked with red
asterisk *)

3. Ignore the Name field (i.e. user will be unable to find name in name list since access has not been
established yet) and complete the remainder of the fields in the account information tab.

4. For Non-City Employee Account(s) - Please attach the appropriate agreements and answer the
questions in the New Non-City Accounts section. If this is the first PRIMELink account for the
business, then a Business Agreement is also required. Both agreements are available at
http://www.sanantonio.gov/CIMS/CurrentVendorResources/COSAPrimeLink.aspx

Note: An individual user agreement is required for every non-city employee requesting an
account.

5. For City Employee Account(s) - Complete the New City Accounts section. Note: If your department
or division is not on the list, put the information in the remarks field. The user id is the same as your
COSA computer logon id.

6. In remark field, enter any other information that will be helpful for the Helpdesk.

To Delete User Account
1. Select Delete from Action drop-down list.
2. Use the Name field selection button to find the user you want to delete. Once selected the
remainder of the information will be filled out.
3. Denote in Remarks field, if this person was on any workflows or other considerations such as
replacing this person with someone else in the workflows.
Note: This action will prevent the user from accessing system for any project. If you want to remove
person from a select project or on-call contract use the Projects or On-Call Contract tabs.

To Modify User Account
1. Select Modify from Action drop-down list.
2. Use the Name field selection button to find the user you want to modify their profile information.
Once selected the remainder of the information will be filled out.
3. Denote in Remarks field, what changes you want the Helpdesk to make on the user’s account.
Note: Use this action to change phone numbers, emails or other account information. This will not
change what projects or on-call contracts the person has access to.

16



5b. Click on Projects Tab, to add, delete or modify a user’s PRIMELink account access to a project.

Use the scroll bar on right side of window to view and complete all of requested information.
Click on Add function button on the bottom of the Project Tab detail section.

Note: A separate line item is required for each user/project combination. If you need to give a person access to
several projects, create the line item for the first project, then copy the line item, open the new line item and
change the project along with any change in remarks.

Add, Delete or Modify User Account Access to Project
1. Select appropriate action from Action drop-down list:
a. Add —if user wants to add user access to a project
b. Delete — if user wants to remove user access to a project
c. Modify — if user want to change what a user role on a project
2. Use the Name field selection button to find the user you want to add/delete/modify. Once selected the
remainder of the information will be filled out. Note: If the user does not yet have an account you will
have to type in the first name, last name and company fields.
3. Choose the Project Role that best fits the user.
4. Use the Project ID selector button to find the project. Note: If you can’t find the project, manually enter
the project name into the Project Name field.
5. Denote in Remarks field, a brief description of what the person will be doing on the project.
This is used by the Helpdesk personnel to determine exactly which groups within the project the person
needs to be in. The groups determine what the user is able to see and do.

17



5c. Click on On-Call Contracts Tab, to add, delete or modify a user’s PRIMELink account access to an on-call
contract.

Use the scroll bar on right side of window to view and complete all of requested information.

Click on Add function button on the bottom of the On-Call Contracts Tab detail section.

Note: A separate line item is required for each user/on-call Contracts combination. If you need to give a person
access to several on-call Contracts, create the line item for the first on-call Contracts, then copy the line item, open
the new line item and change the on-call Contracts along with any change in remarks.

Add, Delete or Modify User Account Access to On-Call Contracts

1. Select appropriate action from Action drop-down list:

a. Add —if user wants to add user access to a on-call Contracts

b. Delete — if user wants to remove user access to a on-call Contracts

c. Modify — if user want to change what a user role on a on-call Contracts
2. Use the Name field selection button to find the user you want to add/delete/modify. Once selected the
remainder of the information will be filled out. Note: If the user does not yet have an account you will
have to type in the first name, last name and company fields.
3. Choose the On-call Contracts Role that best fits the user.
4. Use the On-call Contracts ID selector button to find the on-call Contracts. Note: If you can’t find the
on-call Contracts, manually enter the on-call Contracts name into the On-call Contracts Name field.
5. Denote in Remarks field, a brief description of what the person will be doing on the on-call Contracts.
This is used by the Helpdesk personnel to determine exactly which groups within the on-call Contracts the
person needs to be in. The groups determine what the user is able to see and do.

User Access - Company Line Item:

On-Call Contract Assignments ]
Ifthe user already has an accountin the system, use the Name Field to select the person.

Action: | _gelect- v|
Narne: Select...
First Mame: *
Last Mame: *
Company: *
On-Call Role: | _gelect- v
On-Call Contract Number: Select...
Contract Mame: *

Person's Responsibilities

Tell us what the person will do on the on-call contract or what you want done: approve
invoices and task orders, submit invoices, view information only, or change from an approver

to submitter.
Remarks: |:|
Attachments (0) Linked Records ({0}

18



5d. Click on Templates Tab, to add, delete or modify a user’s PRIMELink account access on templates.

Use the scroll bar on right side of window to view and complete all of requested information.
Click on Add function button on the bottom of the Templates Tab detail section.

Note: This detail tab is used for only those individuals in
Fiscal, Contract Services, Director’s Office, Division Managers, Utility (SAWS/CPS Energy) and TxDOT access groups.

Add, Delete or Modify User Account Access to Templates

1. Select appropriate action from Action drop-down list:

a. Add —if user wants to add user access across all existing projects

b. Delete — if user wants to remove user access from all existing project workflows

(i.e. project templates)

c. Modify — if user want to change what a user’s role on project template
2. Use the Name field selection button to find the user you want to add/delete/modify. Once selected the
remainder of the information will be filled out. Note: If the user does not yet have an account you will
have to type in the first name, last name and company fields.
3. Choose the Template Role that best fits the user.
4. Denote in Remarks field, a brief description of what the person will be doing on the On-Call Contracts.
This is used by the Helpdesk personnel to determine exactly which groups within the on-call Contracts the
person needs to be in. The groups determine what the user is able to see and do.

6. Upon completing the appropriate detail tab(s) part of the form. Select Submit in
Workflow Action list and click on Send.

19



Issue - Internet Explorer 10 and 11 (IE 10) & 11 Incompatibility with PRIMELink system.

Internet Explorer 10 and 11 (IE 10 & 11) Incompatibility

Solution Description - In order to user Internet Explorer 10 or 11 (IE 10 & IE 11) browsers to view PRIMELink you
must enable Compatibility View function.

1. Click and open Internet Explorer Browser (IE 10 or IE 11), navigate to the
https://primavera-unifier.oracleindustry.com/bluedoor/login website
2. Click on Tools on Browser Menu and click on Compatibility View Settings

o U bW

a. If you do not see the Browser Menu, right-click next to the small tab — Not on anything and put a

checkmark on Menu

IE10 IE11
. Where “Add this website:” click on the Add Button, it should add it to the list
. If you have IE11, put a checkmark in the two boxes below
. If you have IE10, put a checkmark in the “Display all websites in Compatibility View”
. Then sign-on to PRIMELink menus should now all be visible and enabled.

oracleindustrv.com

20
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Reports — User-Defined and Custom Reports

There are many reports in the PRIMELIink system that you can use to find out information about your
Project or On-Call Contract current items. To find out want reports are available to you do the following:

Go to your Project or On-Call Contract

Go to the bottom of the menu and click on “Reports”
Select “User-Defined” or “Custom Report”

Under “User-Defined” you may see the following:

pwnpE

5. Under “Custom Reports” you may see the following:

21



6. Under each report you will find a different kind of request page —

a. Nextto Agency you can click on Select, you will see this

Click on the one you want or leave it blank
b. Same for Type of Contract

Click on the one you want or leave it blank
c. Atthe bottom, select either CSV or PDF.
i. CSV will give you a spreadsheet of the items
ii. PDF will give you a PDF of the items.

7. Click on Run to get the report you are requesting.
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